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Overview 
The TSI Link™ Data Analyzer add-in provides an easy way to import acquired data from your TSI Link™ 

devices into Microsoft® Excel® spreadsheet software. It provides a suite of reports to help you gain 

important insight from your data.  

Keep in mind that many other data analysis software packages can import Excel® spreadsheets. You 

can use TSI Link™ Data Analyzer to extract acquired data into Excel® software and then export into 

these packages. 
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Installing Excel® Software Add-In 
You will need Microsoft® Excel® software running on your computer in any of these configurations: 

 Windows® operating system – Excel® 2019 software or newer desktop 

 Macintosh® – Excel® 2018 software or newer desktop 

 Microsoft® 365 operating system  

With the correct version of Excel® software available, you will then need to install the TSI Link™ Data 

Analyzer from the Microsoft® App store. 

1. Open Excel® software and click the Insert tab. 

2. Click the Get Add-ins icon. 

3. A dialog box appears. Click the Store tab. 

4. Enter “TSI Link” into the search box. Locate the TSI Link Data Analyzer add-in and click Add. 

Once the add-in is installed, a TSI Link Data Analyzer icon will appear in the Home tab of Excel® 

software. Click the icon to open the add-in.  
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Connecting to TSI Link™ Data Analyzer 
In order to use the TSI Link™ Data Analyzer, you will need a TSI Link™ account with a API data 

services paid software subscription (click here).  

1. Login into TSILINK.com and go to the https://tsilink.com/api-services menu.   

2. Click on either the “Looking for the legacy (V2) secret? Click her” or “OPEN PORTAL” 

options which are explained below. 

 

Developer Portal Options 

1. Customers will need a V2 Client ID and Secret to access V2 API Data Services. 

The format of this data has not changed. It will be available at least until October 

31, 2023. They should click on the V2 Client ID and Secret: 

 

 
2. Customers wanting API data Services after October 31, 2022 should get a V3 

Client ID and Secret by clicking on click on: 

 

 
a. You will then be directed to developers.tsilink.com. 

 

b. Sign in using the upper right link. 

 

 

https://tsi.com/products/tsi-link-solutions/tsi-link-data-services-and-integration/
https://tsilink.com/api-services
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c. Login with SAML (using the same username and password  

used for TSI Link). 

 

d. Navigate to My Apps. 

 

 
 

e. Access your V3 ID and Secret. 

 

3. Open the downloaded file to copy the "id" and "secret". You will use this later to login 

into TSI Link™ Data Analyzer.  

4. Go back to Microsoft® TSI Link™  Data Analyzer and click the Settings icon at the top 

of the add-in.  

5. Enter “id” in the Client ID field and “secret” for the Client Secret field that are provided 

by the TSI Link™ data services page. Click Save. 
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6. If successful, the top banner of the add-in will return with the message Connected to 

TSI Link. If the banner remains gray, TSI Link™ Data Analyzer did not recognize the 

account information that had been entered. 

User Preferences 

The Settings window also contains a user preference setting. 

If Use Fahrenheit Temperature Scale is checked, all temperature readings will be converted to 

Fahrenheit in the report. 
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Manual Data Retrieval 
Most of the reporting tools available in TSI Link™ Data 

Analyzer require you to first specify a time period to 

analyze. 

1. Click the Data Sources Tab and ensure that Retrieve 

Mode is set to Manual.  

2. Set the Time Filter to the desired time window, such 

as Last 8 Hours. Or to specify a date window, select 

Choose Dates and enter the desired Start Date and 

End Date. 

3. All of the devices associated with your TSI Link™ 

account will be displayed. If you do not want a 

particular device’s data to appear in the report, simply 

uncheck it. 

4. Click Retrieve Data. 

TSI Link™ Data Analyzer will begin downloading the 

requested data from the TSI Link™ server. Download 

status is displayed at the top of the add-in. Large data sets 

may take a while to download. 

When data retrieval has completed, the Data Analysis tab 

will be displayed. The Data Analysis section discusses the 

available analysis tools. 
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Data Analysis 
Once data has been retrieved from TSI Link™ Data Analyzer, you can create a variety of 

customizable reports. 

Time Chart Report 

A Time Chart Report produces a basic data table of any measurements that you select. The 

data sample’s timestamp and device name are the left-most columns in the table. Selected 

measurements are shown in subsequent columns. 

 

 

Customization Option Description 

Add Statistics Table Basics statistics (minimum, maximum, average) for each selected 

measurement are displayed above each measurement.  

Add Report Header Several free text fields appear at the top of the report. These are 

convenient to describe the conditions for the selected data. 

Chart Options If selected, a time chart is displayed for each measurement. Markers can 

be added to each point if desired. The charts can be moved or resized as 

desired. 

 

Once the configuration options are selected, click Create Report to add a new worksheet hosting the 

report data. 

T I P  

To create a data file to export TSI® Link data into another analysis tool, create a Time Chart report with 

none of the customization options selected. Then use the Excel Export feature in the File tab to create 

a CSV file. 
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Time Comparison Report 

A Time Comparison Report is similar to a basic Time Chart 

Report, but it allows you to overlay data from two separate periods 

of time onto the same chart.  

This report is very useful for cause/effect analysis. For example, 

you may want to see what effect adding a standalone air purifier 

has on the PM levels in a room. With this report you can easily 

compare PM2.5 levels before and after the purifier was added. 

Another example could be comparing indoor air quality against 

some external event (wildfire, rush hour traffic, etc.). 

Three controls appear when this report option is selected: 

First Device Specifies the reference device. 

First Period Specifies the starting date and time of your 

baseline data, typically before some 

action/event occurred. 

Second Device Specifies the device to be compared to the 

reference device.  

Second Period Specifies the starting date and time of your 

data that you want to compare against, 

typically after the action/ 

event occurred. 

Duration Sets the amount of time to do the 

comparison, in minutes, hours, or days. 

You can only select date/times that fall within the window of data 

that you have retrieved.  

Select the desired measurements and configuration options, then 

click Create Report. 

The report structure and 

configuration options are 

very similar to the Time 

Chart Report described 

above. A “first” and 

“second” suffix are 

appended to each device in 

the table. The timestamps 

of the second period are 

deliberately altered to match 

the first period so they can 

be overlaid.  
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Device Comparison: Particle Count Report 

A Device Comparison: Particle Count Report is similar to a Time Comparison Report, but it allows you 

to overlay particle count data from two separate devices onto the same chart.  

This report is very useful for filtration analysis. For example, you 

may want to compare an outside reference device to an indoor 

device to investigate filtration efficiency. With this report you can 

easily compare: 

1. Count of particles below 0.5 um. Includes soot, smoke, 

viruses, small bacteria, and atmospheric dust. 

2. Count of particles between 0.5 and 1.0 um. Includes bacteria, 

many types of dust, and smoke. 

3. Count of particles between 1.0 and 2.5 um. Includes pollen, 

bacteria, and many types of dust. 

4. Count of particles between 2.5 and 4.0 um. Includes pollen, 

bacteria, and many types of dust.  

5. Count of particles between 4.0 and 10 um. Includes pollen, 

bacteria, and many types of dust. These particles are most 

likely to deposit in the upper area of the lung. 

You are allowed to select two or more devices when this report 

option is selected: 

Reference 

Device 

The baseline/control device used to compare 

a second device against. 

Second 

Device 

The device used to investigate the area 

of interest. 

The report will use the same date/times you specified when the 

data was fetched using the Data Sources tab.  

Check if you would like a Report Header and choose your desired 

Chart View option then click Create Report. 

The report structure and 

configuration options are very 

similar to the Time Chart Report 

described above. Comparison 

tables and graphs are displayed 

for each selected device.  
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Device Comparison: Selectable Report 

A Device Comparison: Selectable Report is similar to a 

Device Comparison: Particle Count Report, but it allows 

you to overlay any of the Measurements you selected 

under the Data Analysis tab using two separate devices 

onto the same chart.  

This report is very useful for determining if the fresh air intake is 

correct per ASHRAE®. For example, you may want to compare 

the CO2 levels of a supply and return duct to optimize fan speed.  

You are allowed to select two or more devices when this report 

option is selected: 

Reference 

Device 

The baseline/control device used to 

compare a second device against. 

Second 

Device 

The device used to investigate the area 

of interest. 

The report will use the same date/times you specified when 

the data was fetched using the Data Sources tab.  

Check if you would like a Report header and chose your 

desired Chart View option, click Create Report. 

 

 

 

 

 

 

The report structure and 

configuration options are very 

similar to the Time Chart Report 

described above. Comparison 

tables and graphs are displayed 

for each selected device.  
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Floorplan: Statistics Report 

The Floorplan: Statistics Report provides a convenient way to visualize your acquired data in a spatial 

context. While floorplans are the most commonly used visualization, you can use any image including 

photos and maps. 

1. Make sure the Data Analysis tab is selected in the TSI Link™ Data Analyzer. 

2. Select Floorplan: Statistics in the Report drop-down list.  

3. Select the measurements of interest and click Create Report.  

4. A new dialog will appear on top of the Excel® application. Click Image Import.  

5. A file selector will appear. Navigate to your floorplan image and click Open. The floorplan will be 

rendered as shown below. 

 

The slide bar allows you to control the Image Transparency as desired so that the annotations are 

legible against the floorplan background. 

You will next need to manually mark the locations of each device on the uploaded floorplan. The devices 

are listed on the left side of the dialog. Simply click the location of the highlighted device on the image. If 

you want to reposition any device you have already marked, click the device in the list and click the new 

location on the floorplan. As each device is marked, the device name appears as displayed at the 

selected location. 
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You can now display any available measurement by clicking Location Names and selecting the desired 

parameter. The minimum, maximum, and average values over the selected time range are all available. 

These parameters are also stored in table form in the Excel® worksheet.  
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1. Click Done to close the dialog box and make it 

available for Excel® software to use. The 

image will be displayed as a thumbnail in the 

Data Analyzer add-in. 

2. To add the image to your report, click on the 

cell that you want to place the image. Then 

click Insert Picture. The picture can be 

moved or resized as desired. 

3. To show additional measurements in the 

report, click the thumbnail image and repeat 

the process. You will have to upload the 

floorplan image again, but the measurement 

locations have all been saved.  

 

 

 

 

 

 

 

 

 

You may want to add background colors to your 

floorplan measurements to highlight an area of 

concern. To do this, add a background color to 

whichever cells you want to highlight in the Excel® 

table. The example below shows that Max PM1.0 

is a concern for the device TSI Shoreview. A 

yellow highlight was added.  

 

When that measurement is selected on the floorplan, the yellow highlight will also appear. 

T I P  

Common image formats like .gif, .jpg and .png are able to be imported. PDF images are not able to be 

directly imported. There are many online PDF to image converters available, such as 

https://pdf2png.com/. 

https://pdf2png.com/


TSI Link Data Analyzer - Version 1.03  Page 14 of 22 

Floorplan: Playback Report 

The Floorplan: Playback Report provides a convenient way to visualize your acquired data in a both a 

time and spatial context. While floorplans are the most commonly used visualization, you can use any 

image including photos and maps. 

1. Make sure the Data Analysis tab is selected in the TSI® Link Data Analyzer. 

2. Select Floorplan: Playback in the Report drop-down list.  

3. Select the measurements of interest and click Create Report.  

4. A new dialog will appear on top of the Excel® application. Click Image Import.  

5. A file selector will appear. Navigate to your floorplan image and click Open. The floorplan will be 

rendered as shown below. 

 

The slide bar allows you to control the Image Transparency as desired so that the annotations are legible 

against the floorplan background. 

In addition to the ability to adjust the Image Transparency, a Red and Green Threshold is available. The 

Red and Green Thresholds allow you to adjust Red and Green highlights. If the measurement parameter 

exceeds the Red Threshold, a red highlight will be displayed. If the measurement parameter exceeds the 

Green Threshold, a green highlight will be displayed.  

A back-step, play, and forward-step icon allows you to adjust and play throughout the time period. By 

clicking on the time-bar you can quickly advance to the time-frame of interest and then use the back-step 

and forward-steps for fine adjustment.  

You will next need to manually mark the locations of each device on the uploaded floorplan. The devices 

are listed on the left side of the dialog. Simply click the location of the highlighted device on the image. If 

you want to reposition any device you have already marked, click the device in the list and click the new 

location on the floorplan. As each device is marked, the device name appears as displayed at the 

selected location. 
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You can now display any available measurement by clicking Location Names and selecting the desired 

parameter.  

 

Click Done to close the dialog box and make it available for Excel® software to use. The image will be 

displayed as a thumbnail in the Data Analyzer add-in. 

To add the image to your report, click on the cell that you want to place the image. Then click Insert 

Picture. The picture can be moved or resized as desired. 

If you want to show additional measurements in the report, click the thumbnail image and repeat the 

process. You will have to upload the floorplan image again, but the measurement locations have all 

been saved.  
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T I P  

Common image formats like .gif, .jpg and .png are able to be imported. PDF images are not able to be 

directly imported. There are many online PDF to image converters available, such as 

https://pdf2png.com/.. 

Thermal Comfort Report 
The perception of thermal comfort by building occupants is dependent on temperature and humidity. But 

four other environmental and personal parameters are also essential to understanding thermal comfort: 

Mean Radiant 

Temperature 

The amount heat exchanged between building occupants and other surfaces and 

objects in the building. Sunlight, in particular, imparts radiant heat on people 

positioned near windows. Radiators have a similar effect. 

Air Speed Air drafts from doors, windows, HVAC systems, fans, and other building equipment 

impact perceived thermal comfort. 

Metabolic 

Rate 

Higher activity levels generate more internal heating within building occupants. 

Clothing Level Clothing acts as a thermal insulator. 

This report displays temperature and humidity against a thermal comfort window established by these 

four other important parameters. The report is based on key elements of the ANSI/ASHRAE Standard 

55 -2017 Thermal Environmental Conditions for Human Occupancy.  

To create a Thermal Comfort report: 

1. Make sure the Data Analysis tab is selected in the TSI® Link Data Analyzer. 

2. Select Thermal Comfort in the Report drop-down list.  

3. Select the options described in the table below and click Create Report. 

Customization Option Description 

Add Statistics Table Basics statistics (minimum, maximum, average) for each selected 

measurement are displayed above each measurement.  

Add Report Header Several free text fields appear at the top of the report. These are 

convenient to describe the conditions for the selected data. 

Chart Options If selected, a time chart is displayed for each measurement. Markers can 

be added to each point if desired. The charts can be moved or resized 

as desired. 

The Thermal Comfort report will display a table of all temperature and humidity readings for the selected 

devices. It also creates several charts. 

https://pdf2png.com/
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Temperature and humidity are displayed in an x-y chart as shown below. Each measurement is plotted as 

a gray circle. If you hover your mouse over any of these measurements, you can see the exact 

temperature and humidity values. 

 

The thermal comfort window considered acceptable by the ASHRAE® 55 standard is also plotted as blue 

(too cool) and red (too warm) crosses. According to the thermal model, 90% of a typical population would 

consider this to be an acceptable window of comfort. If the temperature and humidity measurements fall 

within this boundary, as shown above, thermal comfort is acceptable. 
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The thermal comfort window is established by four environmental 

and personal factors. 

Mean Radiant 

Temperature 

MRT can be estimated or modeled. TSI® 

QUESTTemp° 34 and 36 heat stress 

monitors are able to make this measurement. 

Air Speed Air speed can also be estimated or modeled. 

TSI® QUESTTemp° 36 with an Air Probe 

accessory is also capable of measuring 

omnidirectional air speed. Air velocity below 

25 fpm is generally considered “still air” while 

velocities over 50 fpm are “noticeably drafty”. 

Metabolic 

Rate 

Select the metabolic rate of building 

occupants from the drop-down list. These 

values are provided in the ASHRAE® 55 

standard. 

Clothing Level Select the typical clothing ensemble of 

building occupants from the drop-down list. 

These values are provided in the ASHRAE® 

55 standard. 

 

 

Consider a simple change to our example. If you alter air speed 

from 20 to 40 fpm, the thermal comfort window moves to the right. 

Now the readings are below the acceptable limit established by 

the ASHRAE® standard. 
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This contextualization provides new insight into the perceived thermal comfort of your building occupants. 

You can now factor in the conditions that your customers and employees experience. You can also begin 

to run “what-if” analyses to estimate energy efficiency retrofits like ceiling fans or shaded windows. 

Time charts of temperature and humidity are also included in the report. 
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Cumulative Data Retrieval 
The Cumulative AQI mode is a specialized reporting tool. Rather than creating a new report from a 

defined period of time, this mode appends data values that meet specified criteria every time you click 

Retrieve Data. 

When you set the Retrieve Mode to Cumulative AQI, a set of 

configurable parameters appear as shown here. 

Start/End 

Time A 

This is the first-time window that will be 

retrieved each day. The example shows a work 

shift from 8 AM to noon. Hours are in 24-hour 

format. 

Start/End 

Time B 

A second work shift can be specified if desired. 

The example shows a second work shift from 

noon to 4 PM. 

Data 

Threshold 

Data will only be appended into the table if the 

Measurement Filter is above the stated 

threshold level. In this example, data will only be 

saved if the total average value over Period A or 

Period B of “pm2.5 aqi” is above 120. You can 

change the measurement filter to any 

parameter, but the spelling must exactly match 

the device measurement name and units must 

be included in parentheses. 

To continue appending data to the report, make sure it is the active 

worksheet. Click Retrieve Data to append and new data since the 

last query. 

This report displays all available measurements from all devices registered to the account. 
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DO NOT alter any of the information in the top three rows. The Data Analyzer add-in needs to maintain 

this status information to append new data. 
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TSI and the TSI logo are registered trademarks of TSI Incorporated in the United States and 
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